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Chapter 3

Menus

Details of 3D WorldÕs File, Edit, View, Options, Palettes and Help menus.
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FILE MENU

◆ New (Command-N)

Opens a new, untitled 3D World document.

If there is a document called Default Stationery Pad located in the same folder as the 3D World 
application, that has been tagged as a stationery pad via the Get Info dialog, a copy of this doc-
ument will be opened as an untitled document. This allows you to use the same customized set-
tings for each document.

◆ Open (Command-O)

Opens an existing 3D World Þle, or any other Þle created by a QuickDraw 3D-compatible 
application.

A standard open dialog displays for you to select the Þle to open: 
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The Þle will open showing the view that was displayed the last time the Þle was saved.

Note: Librarian Þles can be opened directly from within 3D World. Librarian Þles will be 
shown in the standard open dialog, and if a Librarian Þle is chosen to be opened, 3D World will 
launch the Librarian application to open the Þle.

Show Preview

Click on this checkbox to extend the dialog and display a preview of the Þle (if one is avail-
able). If no preview has been saved for the Þle and the Create button is enabled, click Create to 
create a preview. Uncheck the Show Preview checkbox to reduce the window and hide the pre-
view display area.

◆ Insert

Select Insert to bring QuickDraw 3D, PICT, or text Þles into 3D World documents.

When the standard dialog displays, select a Þle to insert. The Insert Dialog will display:
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The options available will depend upon the type of Þle selected, and whether an object was 
selected when Insert was chosen. The type of Þle selected will be indicated on the left side of 
the dialog.

Add as Object

The selected Þle appears either in the center of the grid or at the last place the mouse was 
clicked.

¥ QuickDraw 3D Þle: Appears as a 3D object, the orientation of which will depend on the 
information contained in the QuickDraw 3D Þle.

¥ PICT Þle: The PICT image displays as a rectangle with the same proportions as the original 
picture. The longest side of the rectangle is equivalent to the length of one side of one grid 
square and its orientation relates to the World Coordinate System.
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¥ Text Þle: Text is placed in the document as a text marker. The marker has a speciÞc location 
within the document, but the text is always displayed perpendicular to the camera, regard-
less of the view.

Add to Object

This option is only available if an object was selected in the document before Insert was cho-
sen. The Þle is converted to a PICT (if necessary) and applied to the selected object as a tex-
ture. The properties of the selected object will determine how it is applied.

Available for:

¥ QuickDraw 3D Þle

¥ PICT Þle

¥ Text Þle
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Foreground/Background Picture

The Þle is converted to a PICT (if necessary) and placed in the foreground/background where it 
remains even if the view changes. If the proportions of the PICT image are not the same as the 
proportions of the window, the PICT image is distorted to Þt the window. Its size remains con-
stant relative to the window size.

Available for:

¥ QuickDraw 3D Þle

¥ PICT Þle

¥ Text Þle
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◆ Import

The Import option allows you to access Import plug-ins.

Open the Þle menu and select Import. A submenu lists the installed Import plug-ins. Select the 
plug-in you wish to use from the list. See Appendix A Ñ Import Plug-ins on page A-1 for fur-
ther details.

◆ Export

The Export option allows you to access Export plug-ins.

Open the Þle menu and select Export. A submenu lists the installed Export plug-ins. Select the 
plug-in you wish to use from the list. See Appendix B Ñ Export Plug-ins on page B-1 for fur-
ther details.

◆ Close (Command-W)

Closes the current document and its associated windows. If the document has not been saved, 
or if changes have been made to it since it was last saved, an alert will display asking if you 
want to save the document before closing.

◆ Save (Command-S)

The Save option is only available if a document has never been saved, or if changes have been 
made to it since it was last saved. Using the Save option saves the document in 3D metaÞle for-
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mat. If the document has not been saved before, a dialog will display for you to specify the doc-
ument name and a location to save it.

To save a document as a stationery pad, give it the name Default Stationery Pad. The document 
will be automatically tagged as a stationery pad. See New on page 3-3 for information about 
opening the Default Stationery Pad.

◆ Save As

Choose to save a document (in 3D metaÞle format) under a different name or in a different 
location. If you try to save a document in the same location as a document of the same name, an 
alert will ask if you wish to replace the existing Þle.

◆ Revert

Returns to the last saved version of a document. (This option will only be available if the docu-
ment has been previously saved.) An alert will display to ask if you are sure you wish to revert.

◆ Page Setup

Select to display the Page Setup dialog. The options available in the Page Setup dialog will 
depend on the printer driver you have selected in the Chooser.
3-9



          
◆ Print (Command-P)

Select to display the Print dialog. The options available in the Print dialog will depend on the 
printer driver you have selected in the Chooser.

◆ Print One

Prints one copy of the current window without displaying the Page Setup and Print Dialogs.

◆ Quit (Command-Q)

Quits the application and closes all open Þles and their associated windows. If any open Þles 
have been changed without being saved, a dialog will display asking if you wish to save the 
changes.
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EDIT MENU

◆ Undo (Command-Z)

Allows you to undo your last object manipulation. Selections, de-selections, mode changes and 
view changes are not object manipulations, and therefore cannot be undone.

This option will be disabled if no 3D World document is open, if an open document has not 
been changed since it was last saved, or if Do Undos has been turned off in the Preferences dia-
log. See Do Undos on page 3-23 for further details.

After an object manipulation has been undone, the Undo option will change to Redo. Select 
Redo to perform the action again.
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◆ Cut (Command-X)

Removes a selected item from the current document and places it on the clipboard, where it 
remains until replaced by another item cut or copied from the document.

◆ Copy (Command-C)

Copies a selected item from the current document and places it on the clipboard, where it 
remains until replaced by another item cut or copied from the document.

◆ Paste (Command-V)

Pastes items into the current Þle either in the center of the grid or at the last place the mouse 
was clicked. 3DMF, PICT, text, and sound Þles can be pasted into 3D World documents. 
3DMF data are pasted in as 3D objects; PICT Þles are pasted in as rectangles; text and sound 
data are pasted in as markers.

◆ Paste Special

Paste Special is only available if you have cut or copied items from an application other than 
3D World. When you select Paste Special, the following dialog displays:
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Items cut or copied from other applications can be placed in 3D World documents in a variety 
of ways, depending on their formats. If you have cut or copied multiple data types, you can use 
the list on the left of the Paste Special dialog to select the data type you want to place in your 
document.

The Paste Special options available to you will depend on the type of Þle selected, and whether 
an object was selected prior to choosing Paste Special.

Add as Object

The Þle will appear either in the center of the grid or at the last place the mouse was clicked.

¥ 3D Object: Appears as a 3DMF, the orientation of which depends on the information con-
tained in the 3D object Þle.

¥ Picture: The PICT image displays as a rectangle with the same proportions as the original 
picture. The longest side of the rectangle is equivalent to the length of one side of one grid 
square, and its orientation relates to the World Coordinate System.
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¥ Text/Sound: Placed in the document as a text/sound marker. The marker has a speciÞc loca-
tion within the document, but always displays perpendicular to the camera, regardless of 
the view.

Add to Object

This option is only available if an object was selected in the document prior to choosing Paste 
Special.

Available for:

¥ 3D object: The Þle is converted to a PICT and applied to the selected object as a texture. 
The properties of the selected object will determine how it is applied.

¥ Picture: The Þle is applied to the selected object as a texture. The properties of the selected 
object will determine how it is applied.
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¥ Text: The Þle is converted to a PICT and applied to the selected object as a texture. The 
properties of the selected object will determine how it is applied.

¥ Sound: The sound is applied to the selected object as an attribute. To play the sound, click 
on the object.

Foreground/Background Picture

The Þle is converted to a PICT (if necessary) and displayed in the document foreground/back-
ground where it remains even if the view changes. If the proportions of the PICT image are not 
the same as the proportions of the window, the PICT image is distorted to Þt the window. Its 
size remains constant, relative to the window size.

Available for:

¥ 3D object

¥ Picture
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¥ Text

◆ Clear

Use the Clear command to remove items or attributes without placing them on the clipboard. 
The six options in the top part of the popup menu are only available if an item is selected 
within the document before Clear is chosen.

Select the appropriate option to clear the entire object, or a speciÞc attribute of the object. An 
entire object can also be cleared from a Þle by dragging and dropping it into the trash can. 
Although the object will be removed from the Þle, a clipping will remain in the trash can until 
it is emptied. This allows you to drag and drop the item back into the document if necessary.

The last three options in the Clear menu allow you to remove the documentÕs background 
color, background picture and foreground picture.
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◆ Select All (Command-A)

Selects all of the objects in the current window.

◆ Select None

Deselects all of the selected items in the current window.

◆ Duplicate (Command-D)/Clone (Command-=)

Note: Clone is available only if QuickDraw 3D version 1.0.4 or later is installed, otherwise it 
will be grayed out. This is due to a bug in prior versions of QuickDraw 3D.

The Duplicate and Clone operations appear identical, however, when an object is duplicated, 
the duplicate is created as an entirely separate item and is unrelated to the original. When an 
object is cloned, the clones share the same basic geometry and surface attributes as the original. 
This means that if the geometry, color, transparency, shininess etc. of the original is changed, 
any clones will also be changed, and if a clone is changed, other clones and the original will be 
changed. The link relates to the basic geometry and surface attributes only. Changes in size, 
position and rotation will not be reßected by the clones.

The Clone command can be very useful in certain situations as due to their shared attributes, 
clones use less memory than duplicates, and changes can be made quickly to several cloned 
objects at once.

1. Select an item or group of items and choose Duplicate/Clone.
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2. A duplicate/clone of the selected item or group of items is placed one grid square to the 
right of the original:

3. Move the duplicate/clone and choose Duplicate/Clone again.

4. The second duplicate/clone will be positioned in the same position relative to the Þrst 
duplicate/clone, as the Þrst duplicate/clone was to the original:
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Any rotations that are applied after the Þrst duplication are also applied to subsequent dupli-
cated items. This is useful for drawing items like spiral staircases.

Hold down the Shift key when using the Duplicate/Clone option to avoid applying any offset.

◆ Group (Command-G)

Groups two or more objects and allows them to be manipulated as a single object.

1. Select the desired items, then choose Group. Grouped items will be surrounded by a 
bounding rectangle or sphere:

2. Double-click on the group or choose Edit Item from the Options menu to open a new 
window containing only the items within the group:
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3. Manipulate these items individually, then close the window to view your changes in the 
original document:

While a Group window is open, the handles of the bounding rectangle or sphere around the 
original grouped items will change color. This indicates that the objects are selected, and the 
Group window is open. The color of the handles is set in the Preferences dialog. See Color 
Preferences on page 3-22 for further details.

If the grouped objects have been placed in further groups, the Group window will contain 
grouped objects. Double-clicking on these groups will open additional windows showing the 
contents of their respective groups.

If a group of objects is ßagged as Primitive, it is not possible to edit the items within the group 
by double-clicking on the group or choosing Edit Item from the Options menu. The group must 
be ßagged as Dismantleable before the individual items can be edited. The Primitive and Dis-
mantleable options are available in the Options menu and the Info palette, and are discussed 
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further in the sections Primitive on page 3-33, Dismantleable on page 3-34 and Primitive/Dis-
mantleable Flag on page 4-19.

◆ Ungroup (Command-U)

Ungroups selected items so that members of a group can be selected individually. Note that this 
option only ungroups one level at a time.

If a group is ßagged as Primitive, the Ungroup option will be grayed out in the Edit menu, and 
will not be selectable. The group must be ßagged as Dismantleable before it can be ungrouped. 
The Primitive and Dismantleable options are available in the Options menu and the Info pal-
ette, and are discussed further in the sections Primitive on page 3-33, Dismantleable on page 3-
34 and Primitive/Dismantleable Flag on page 4-19.

◆ Preferences

Select Preferences to display the Preferences dialog:
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Color Preferences

To change color preferences, click on a color square to display the Color Picker. Select a new 
color and close the Color Picker.

¥ Handle Color: The color of the handles on the bounding frame of a selected object.

¥ Open Handle Color: The color of the handles on the bounding frame of a group of objects 
when an Editing or Group window is open.

¥ Locked Handle Color: The color of the handles on the bounding frame of a locked object.

¥ Light Marker Color: The color of the cone or point marking the position of a Spot/Point 
Light. If this color is set to white, the color of each light marker will be the same as the 
color of the light.

¥ Grid Color: The color of the grid.

¥ Background Color: The color displayed in the background of a new Þle.

¥ Default Color: The color that displays in the color block in the window toolbar, and is used 
to draw new objects.

Default Tool

Choose either the Arrow or Rotate Tool as the default tool.

Options

¥ High Resolution Printing: Click to print at printer resolution rather than screen resolution 
(72 dpi).

¥ Sound On: Click to play sounds within the 3D World application.

¥ Dynamic Updates: If this option is enabled, all open windows for a particular document 
will automatically be updated as objects are created or manipulated in the active window 
and as slider bar controls in palettes are changed. If this option is not enabled, only the 
active window will be updated as actions are performed. Other open windows will not be 
updated until the action is complete. When moving slider controls, views will not be 
updated until the mouse is released.

¥ Solid Grid: Click to specify that the document grid should appear as a solid ßoor rather 
than a wire frame grid.
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¥ Global Lights: When this check box is enabled, the controls in the Lights palette relate to 
the 3D World document. When it is unchecked, the controls in the Lights palette affect 
only the active window.

¥ Do Undos: The Do Undos checkbox is used to specify whether or not you wish to be able to 
use the Undo command. It is checked on by default.

To be able to perform an Undo command, when anything in the 3D World document win-
dow is changed, 3D World must store a copy of the document (or parts of it) before carry-
ing out the required action. This means that you potentially need twice as much memory to 
be available for 3D World, as the document itself requires. It also means that for large doc-
uments, the time it takes 3D World to store the copy of the Þle may result in unacceptably 
slow updates as you edit your document. Unchecking the Do Undos checkbox will there-
for allow 3D World to use less memory and also speed up the updating of large documents.

¥ Undo Time-out: As an alternative to completely disabling the Undo command, you can 
leave the Do Undos checkbox checked on, and enter a value in seconds in the Undo Time-
out Þeld. This speciÞes the amount of time that you are prepared to give 3D World to store 
a copy of the document. If a copy of the document cannot be stored in the time speciÞed, 
no copy will be saved and the Undo command will not be available. The default setting of 
0 seconds gives unlimited time.

¥ Edges to a Circle: Enter a value for the number of sides a circle should have. This will affect 
the appearance of circles, spheres, cylinders, lathed objects, etc. The lower the value, the 
coarser the curve. The higher the value, the more memory and disk space you will need to 
display and store the images. The default value is 24.

◆ Show Clipboard

Choose this option to display the clipboard, which stores items that have been cut or copied 
from applications. The contents of the external clipboard can only be displayed if they can be 
recognized.

Use the controls at the bottom of the Clipboard window to view stored items:
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Camera

Click on the Camera icon and hold down the mouse to display the Camera popup menu.

Use the options in the Camera menu to change the view of an item on the clipboard. The 
options available will depend on the version of QuickDraw 3D installed.

Viewing Tools

Click on an icon and move the cursor over the item in the Clipboard window. Hold down the 
mouse, then click and drag over the item

¥ Distance: Use to move closer to, or further away from, an item:

¥ Rotate: Use to rotate an item. To rotate the camera around the item, position the cursor over 
the clipboardÕs background and drag while holding down the mouse:

Camera

Distance
Rotate

Perspective

Move
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¥  Perspective: Changes the perspective view of an item:

¥  Move: Moves an object up, down, left or right:
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VIEW MENU

◆ New Window (Command-K)

Opens a new window for the current document. The new window displays the same view as the 
original window, and is offset from it. Use the Change View menu to change the view in the 
new window to display a different view of the same document. See Change View on page 3-28 
for further details.

◆ Close Window

Closes the current window. If this is the last open window for a document, the document will 
also be closed. If you have made changes to the document since it was last saved, an alert dis-
plays asking if you want to save the changes. If you save your changes then later reopen the 
document, the same view as when the document was closed will be displayed. To save a view 
with a name, use the Name View option before closing the window. See Name View on page 3-
26 for further details.

◆ Name View

Saves the current view. Enter a name for the view in the dialog that displays:
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You cannot use the names of the standard views included in the program. If you specify a name 
that has already been used to save a nonstandard view, an alert displays asking if you want to 
replace that view.

◆ Delete View

Deletes a saved view. This option is only available when new views have been created and 
saved (standard program views cannot be deleted).

1. Select Delete View to display a dialog listing the views that may be deleted:

2. Select the view to delete and click OK. If a document window was displaying a view 
that has now been deleted, the window will remain open as an untitled view.
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◆ Change View

Click on Change View to display a popup menu which lists the available views (including any 
that you have saved). The view in the current window will be indicated by a check mark. Move 
the cursor down the list to select the desired view:

The current window will change to reßect your choice. If a standard view has been changed, 
hold down the Option key and select the name of the standard view to reset it to the default 
standard view.

The view displayed can also be changed via the Command key shortcuts shown in the Change 
View popup menu above, or through the popup menu in the Window toolbar. See View on page 
4-34 for further details.

Look at Selected

Displays a selected object in the center of the window:

Home View

Returns the camera to its initial position (the view displayed when a new Þle is opened):
3-28



Custom

Any nonstandard view, or any view that has not been saved is a Custom view.

Top, Front, Left, Right and Back

The Þve standard views that allow you to display the Þle from the sides and top:

Last View

The view that was displayed in the window immediately prior to the current view.
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◆ Open Documents

At the bottom of the view menu is a list of the documents and views that are currently open. 
The active window has a check mark to the left of its name. Documents that have been changed 
since they were saved are underlined. Select a document/window name from the list to make it 
the active window:
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OPTIONS MENU

◆ Edit Item

Select to edit individual objects within a group.

Double-click on the group, or select the group and choose Edit Item from the Options menu, to 
display a new window which contains only the items in the group.
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The items can now be edited individually. As you edit the individual items, the group remains 
locked in the original Þle window, although it will be updated to reßect any changes you make.

Hold down the Option key when closing an editing window, and all editing windows for that 
Þle will be closed.

Items and groups can be ßagged as Primitive or Dismantleable. If the selected group has been 
ßagged as Primitive, Edit Item will be grayed out and will not be selectable. Flag the group as 
Dismantleable to edit it. The Primitive and Dismantleable options are available in the Options 
menu and the Info palette. See Primitive on page 3-33, Dismantleable on page 3-34, and Prim-
itive/Dismantleable Flag on page 4-19 for further details.
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◆ Lock

Protects a selected object or group from being changed. A locked object can be grouped with 
other objects, but cannot be moved, resized or changed. If you group a locked object with other 
objects, the entire group will be locked.

If you place the cursor over a locked object, it will display as a padlock.

An object or group can also be locked by selecting it and clicking on the large open padlock 
icon in the top right corner of the Info Palette. See Lock on page 4-20 for further details. 

◆ Unlock

Select a locked object or group and choose Unlock to remove the protection against changes. 
An object or group can also be unlocked by selecting it and clicking on the large closed pad-
lock icon in the top right corner of the Info Palette. See Lock on page 4-20 for further details.

◆ Primitive

SpeciÞes that an item or group should be treated as a basic geometry. A basic geometry cannot 
be ungrouped, so individual surfaces or items cannot be edited. An alternate method of specify-
ing an object as a Primitive is to click on the Primitive/Dismantle button in the Info Palette. See 
Primitive/Dismantleable Flag on page 4-19 for further details.
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◆ Dismantleable

Specify that an item or group can be broken down into its component parts. This will allow you 
to ungroup an item or items and edit individual components as separate items. An alternative 
method of specifying an object as Dismantleable is to click on the Primitive/Dismantle button 
in the Info Palette. See Primitive/Dismantleable Flag on page 4-19 for further details.

◆ Autogrid (Command-Y)

Autogrid applies an invisible grid to the document to which object points can snap. It is 
enabled by default to make it easier to align objects. The distances between the nodes on this 
grid are determined by the value entered for the Snapping Grid Distance in the Grid Options 
dialog. See Grid Options on page 3-34 for further details.

When Autogrid is enabled and a new item is entered, the cursor is positioned on the closest 
snapping grid intersection. As the object is drawn, the objectÕs handles snap to the snapping 
gridÕs intersection points. As an object is resized, the objectÕs handles are positioned on snap-
ping grid intersection points. When an item is moved, its center point will snap to the snapping 
grid intersection points.

If Autogrid was disabled when an object was randomly positioned in the Þle, the item will be 
moved or resized in increments of the snapping grid distance when Autogrid is enabled.

Reselect the Autogrid option in the Options menu to turn this option off.

◆ Grid Options

Choose Grid Options to display the Grid Options dialog:
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¥ Number of grid squares: This value relates to the visible grid. Enter a value to specify the 
number of grid squares that should make up one side of the grid.

¥ Grid square size: This value relates to the visible grid. Enter a value to specify the length of 
one side of one grid square.

¥ Snapping grid distance: This value deÞnes the invisible snapping grid. Enter a value for the 
length of one side of one snapping grid square. Typically, you will want to give the snap-
ping grid distance a value that is a fraction or multiple of one document grid square.

¥ Preferred unit size: This option allows you to select a unit size.

The entries in the popup menu are determined by whether metric or inches has been 
selected in the Options menu as discussed below.

◆ Metric (Command-M)

Select this option to use metric units of measurement. The grid size, coordinates and dimen-
sions will all be calculated using metric units. 
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◆ Inches (Command-I)

Select this option to use inches or feet as units of measurement. The grid size, coordinates and 
dimensions will all be calculated using inches or feet.

◆ Auto Look At 

Allows you to easily change the document view to display a selected object or point in the cen-
ter of the view.

Select Auto Look At, then move the cursor to the area you wish to view and click the mouse. 
The view will change to reßect your actions: 

Reselect this option to disable it.
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◆ Constrain To Page Setup

Constrains the window to the proportions of the page size selected in the Page Setup dialog. 
Select this option and a dotted outline representing the page appears in the center of the win-
dow. Change the window size via the Window Zoom Box or Window Resize Box and the win-
dow will be constrained to the page proportions. Reselect the option to remove the constraint.

◆ Animation On

Allows you to turn animation on and off for the current document. Select the item from the 
menu: animation will be turned on and a checkmark will appear by the item name. To turn ani-
mation off: select the menu item again. Animation can also be turned on and off using the Ani-
mation Player or Animation Tweener palette. See Animation Player on page D-12 and 
Animation Tweener on page D-17 for further details.
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◆ Spin Around Look At (Command-T)

Select Spin around Look At to rotate a view around the point at the center of the view. Click 
anywhere in the window to stop the rotation.
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PALETTES MENU

Click on Palettes in the 3D World menu bar to display a list of available palettes. Select the pal-
ette name from the list to open it.

The Tools, Info and Help palettes are the standard palettes included in the 3D World applica-
tion. All other palettes are plug-in palettes that can be loaded when 3D World is launched or 
while the application is running.

See Chapter 4 Ñ Palettes on page 4-1 for details of the Tools, Info and Help palettes, Appendix 
D Ñ Plug-in Palettes on page D-1 for details of plug-in palettes, and Installing Plug-ins on 
page 1-6 for details of installing plug-ins.
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HELP MENU

◆ About Balloon Help

Select this option to display information about Balloon Help.

◆ Show/Hide Balloons

Select Show Balloons to display Balloon Help messages. When Show Balloons has been 
selected, this menu item changes to Hide Balloons. Select Hide Balloons to stop displaying the 
Balloon Help information.

◆ 3D World Online Manual

Select this option to launch Acrobat Reader (if available) and display the 3D World Online 
manual.
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